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Pocetak rada

u Excelu

ovom delu pronadi éete osnovne informacije o Excelu i

nauciti da radite s njegovim najvaznijim alatkama. Ako

ste ve¢ koristili Excel (ili neki drugi program za tabe-
larne proracune), za vas ¢e veci deo ove celine biti obnavljanje
znanja. Cak i da je tako, sigurni smo da éete ovde pronaéi popri-
lican broj korisnih trikova i tehnika za rad u Excelu.”

* Primeri u ovoj knjizi prilagodeni su na$im standardima za pisanje
brojeva, valuta, datuma i vremena, kao i za nabrajanje. Mnogi primeri
nece raditi ukoliko va$ operativni sistem i Excel ne podesite na isti nacin.
U operativnom sistemu Windows 7, pritisnite dugme Start i izaberite
Control Panel. Pritisnite kategoriju Region and Language. Na kartici
Formats, u listi Format izaberite stavku Serbia (Latin Serbia). U opera-
tivnom sistemu Windows Vista, pritisnite dugme Start, pa izaberite
Control Panel. Potom pritisnite Clock, Language, and Region, a zatim
Change the date, time, or number format. (U prikazu Classic, dvaput
pritisnite Regional and Language Options). Zatim, na kartici Formats,
na listi Current format izaberite ,,Serbian (Latin)“. Ako koristite opera-
tivni sistem Microsoft Windows XP, prvo zatvorite sve programe iz pa-
keta Microsoft Office. Pritisnite dugme Start, pa izaberite Control Panel.
Pritisnite Date, Time, Language, and Regional Options, a zatim Regi-
onal and Language Options. (U prikazu Classic, dvaput pritisnite Re-
gional and Language Options.) Na kartici Regional Options izaberite
»Serbian (Latin)“ na listi Standards and formats.

U OVOM DELU

Uvod u Excel

Unosenje podataka u radni list
i njihovo menjanje

Najvaznije operacije na radnim
listovima

Rad sa celijama i podrucjima

Uvod u rad s tabelama

Formatiranje radnog lista

Rad s datotekama

Izrada i upotreba sablona

Stampanje







ovom poglavlju dajem uvodni pregled Excela 2010. Cak _
i ako ste koristili prethodnu verziju Excela, dobro bi bilo OM POGLAY

da procitate ovo poglavlje. Uvericete se da je Excel 2010 Namena Excela

veoma sli¢an Excelu 2007. Medutim, i Excel 2007 i Excel 2010

Sta je novo u Excelu 2010
razlikuju se od svih prethodnih verzija programa — i to mnogo. )

Delovi Excelovog prozora

U cemu je Excel dobar? Predstavljanje korisnickog
Verovatno ve¢ i sami znate da je Excel najkorisceniji program za okruZenja trake s komandama,
tabelarne proracune, koji se isporucuje kao deo paketa Micro- 5;}';:::;"‘ REH
soft Office. Postoje i drugi sli¢ni programi, ali Excel je najpopu-
larniji i postao je svetski standard. Kretanje po radnim listovima
Jedna od najvecih prednosti Excela jeste to $to ima vise
namena. Njegova osnovna namena su numericka izra¢unavanja,
ali je vrlo koristan i u nenumeric¢kim primenama. Naves¢éemo
nekoliko nacina za kori$¢enje Excela:

Primer: izrada radnog lista

B Obrada numerickih podataka Izrada proracuna, analiza rezultata, i moguénost bilo
kog tipa finansijske analize koji mozete da zamislite.

B Izrada dijagrama Moguc¢nost izrade Sirokog spektra dijagrama koji se mogu
prilagodavati potrebama korisnika.

B Organizovanje spiskova Upotreba redova i kolona za efikasno memorisanje spiskova.

B Pristup drugim podacima Uvoz podataka iz raznih izvora.

B Izrada zbirnih grafickih prikaza (engl. dashboard) Koncizan prikaz velikog broja
poslovnih informacija.

B Izradaslikaidijagrama Upotreba alatke Shapes i nove alatke SmartArt za izradu
dijagrama profesionalnog izgleda.

B Automatizovanje sloZenih zadataka Efikasno obavljanje zadataka jednim pritiskom
na taster misa.
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Sta je novo u Excelu 2010?

Kada izade nova verzija Microsoft Officea, Excel ponekad krasi obilje novih funkcija, dok ih
ponekad bude vrlo malo — $to je sluc¢aj sa Excelom 2010. Evo kratkog prikaza ¢ega to ima
novog u Excelu 2010 u odnosu na Excel 2007:

64-bitna verzija. Ako vas hardver (i verzija Windowsa) to podrzava, mozete instalirati
64-bitnu verziju koja omogucava izradu veéih radnih svezaka. Veéini korisnika ta ver-
zija nije potrebna, a moze se desiti da neki dodatni programi zbog nje nece raditi.
Mini-grafikoni (engl. sparklines). Napravite male grafikone unutar elije radnog lista
kojima se grafi¢ki rezimiraju izneti podaci. Videti poglavlje 21.

Funkcija Slicer. Nov nacin za filtriranje i prikaz podataka u izvedenim tabelama priti-
skom na odgovaraju¢u dugmad. Videti poglavlje 35.

Nove opcije za formatiranje izvedenih tabela. Pobolj$ano formatiranje izvestaja sa
izvedenim tabelama. Videti poglavlje 35.

Zamenjeno dugme Office. Veliko okruglo dugme Office iz Excela 2007 zamenjeno je
dugmetom, tj. karticom File sme$tenom levo od svih ostalih kartica. Kada je pritisnete,
otvara se prozor preko koga obavljate razne operacije na radnom listu. U sustini, on je
zamenio stare menije File i Print ali i dobio jo§ mnogo novih opcija.

Poboljsano uslovno formatiranje. Trake podataka mogu se iscrtati u jednoj boji (ne
kao preliv) ¢ime se obezbeduje precizniji prikaz. Videti poglavlje 20.

Poboljsane funkcije. Nekoliko Excelovih finansijskih i statisti¢kih funkcija pobolj$ano
je tako da sada daju numericki preciznije rezultate.

Poboljsana obrada slika. Sada imate mnogo vi$e kontrole nad slikama koje umecete u
radnu svesku, a pruza vam se i mogucnost da uklonite nepotrebne delove s pozadine
slike.

Alatka za snimanje ekrana. Lako mozZete snimiti prozor nekog drugog programa i
potom ubaciti tu sliku na radni list.

Pregled stavki koje umecete alatkom Paste. Kada kopirate niz, komanda Paste prika-

zuje razli¢ite opcije kopiranih stavki pa tako vidite kako Ce izgledati krajnji ishod ume-
tanja.

Prilagodavanje komandne trake. Mozete prilagoditi komandnu traku programa tako
$to Cete joj dodati nove kartice i grupe.

Funkcija Equation Editor. Sastavljajte i prikazujte matematicke jednacine (kao gra-
ficke objekte) i ubacujte ih na radne listove. Videti poglavlje 22.

Brzi rad. Microsoft je donekle pobolj$ao sistem za izra¢unavanje, a i datoteke se udita-
vaju malo brze.

Nove bezbednosne funkcije. Radne sveske koje se preuzimaju sa interneta ili kao pri-
lozi e-poste otvaraju se u rezimu zasti¢enog prikaza (engl. protected view mode). Radne
sveske mogu se oznaciti kao ,,bezbedne® i kao takve se ne moraju smestati u specijalne,
bezbedne omotnice.

Alatka Solver. U Excel 2010 ugradena je nova verzija dodatnog modula Solver koji je
namenjen re$avanju sloZenijih zadataka.

Poboljsani VBA makroi. Operacije za koje su bili potrebni stari XLM makroi sada se
mogu izvoditi direktno pomoc¢u VBA makroa. Pored toga, sada se kao makroi mogu
snimati i operacije poput formatiranja oblika dijagrama.
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Radne sveske i radni listovi

Sve ono §to radite u Excelu, smesta se u datoteke koje nazivamo radne sveske (engl. workbook).
Radne sveske se prikazuju u zasebnim prozorima i mozete otvoriti onoliko svezaka koliko
Zelite. Podrazumevana oznaka tipa datoteke radnih svezaka u Excelu 2010 jeste XLSX.

Svaka radna sveska sastoji se od jednog ili vise radnih listova (engl. worksheet), a svaki radni
list se sastoji od pojedinac¢nih celija (engl. cell). Celije sadrze vrednosti, formule ili tekst. Radni
list sadrzi i nevidljivi sloj za crtanje (engl. draw layer) na kom se nalaze grafikoni, slike i dija-
grami. Svakom radnom listu u radnoj svesci mozete pristupiti ako pritisnete jezicak lista (engl.
tab) na dnu prozora radne sveske. U radnoj svesci mogu se ¢uvati i listovi s dijagramima. Na
listu s dijagramom (engl. chart sheet) prikazuje se jedan dijagram i takode mu se pristupa tako

§to se pritisne jezicak lista.

Novi korisnici su Cesto uplaseni zbog brojnih elemenata Excelovog prozora. Kada se upo-
znate s njegovim raznim delovima, sve ¢e dobiti smisao.

Slika 1.1 prikazuje najvaznije elemente Excela. Dok posmatrate stavke na slici, pratite
njihova objasnjenja u tabeli 1.1.

Tabela 1.1:

Delovi Excelovog prozora koje morate znati

Naziv

Opis

Indikator aktivne Celije

Ovaj tamni okvir oko Celije oznacava da je ona aktivna (jedna od
17.179.869.184 Celije, koliko ih ima na svakom radnom listu).

Dugme za zatvaranje aplikacije

Kada pritisnete ovo dugme, zatvarate Excel.

Dugme za minimiziranje
aplikacije

Ako pritisnete ovo dugme, minimiziracete Excelov prozor.

Slovne oznake (zaglavlja) kolona

Niz slova od A do XFD - po jedno za svaku od 16.384 kolone na rad-
nom listu. Kada pritisnete zaglavlje kolone, izabracete celu kolonu, a
kada povucete ivicu kolone, promenicete joj Sirinu.

Dugme File

Ovo dugme vodi do mnogih opcija za rad s dokumentom (ukljucujuci
Stampanje) i za rad u Excelu uopste.

Polje za formule

Kada unesete podatke ili formule u Excel, oni se prikazuju u ovom polju.

Dugme Help

Kada ga pritisnete, prikazuje se Excelov sistem pomodi.

Horizontalna klizna traka

Omogucava horizontalno pomeranje sadrzaja radnog lista.

Indikator snimanja makroa

Kad pritisnete ovo dugme, zapocinjete snimanje VBA makroa. Ikonica
menja izgled dok snimate akcije. Snimanje prekidate ponovnim priti-
skom na isto dugme.

Dugme za minimiziranje trake
s komandama

Pomocu ovog dugmeta sakrivate traku s komandama i tako dobijate
dodatni prostor na ekranu. Kada pritisnete neku karticu, traka se vraca
na ekran.

Polje za ime

Prikazuje adresu aktivne Celije, ili ime izabrane Celije, podrugja ili
objekta.

Dugmad za promenu prikaza
strane

Pomocu ove dugmadi menjate nacin na koji je radni list prikazan.

Paleta alatki Quick Access
(paleta za brz pristup opcijama)

Mozete je prilagoditi tako da sadrzi najcesce koris¢ene komande.
Paleta je uvek vidljiva, bez obzira na to koja je kartica izabrana.

Traka s komandama (Ribbon)

Glavno mesto Excelovih komandi. Kada pritisnete stavku s liste
jezi¢aka, promenice se prikaz na traci.
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Zatvaranje aplikacije

Maksimiranje / vra¢anje

— Polje za ime prozora na prethodnu veli¢inu
— Traka s komandama  Polje za formule _ Maksimiranje / vra¢anje
. aplikacije na prethodnu veli¢inu
Paleta alatki Lista o
Quick Access jeziaka Minimiziranje prozora
Dugme Naslovna Indikator aktivne Minimiziranje aplikacije
File traka celije Minimiziranje trake ~ Pomo¢ |
| | |
'E ' L= =t
5 - ¥ - }. _: ' |‘1i
I R u Y N EE
=

S

Snimanje Jezi¢ci radnih Brojéane oznake  Slovne Celije | Dugmad za promenu Kontrola
makroa listova redova oznake kolona prikaza strane uveli¢anja

Statusna traka

Dugmad za pomeranje jezi¢aka listova Zatvaranje prozora

Horizontalna klizna traka Vertikalna klizna traka

Slika 1.1: Excelov prozor sadrzi korisne elemente koji se ¢esto upotrebljavaju.

Tabela 1.1: Delovi Excelovog prozora koje morate znati (nastavak)

Naziv

Opis

Brojc¢ane oznake redova

Niz brojeva od 1 do 1.048.576, po jedan za svaki red na radnom listu.
Ako pritisnete broj reda, izabracete ceo red.

Jezi¢ci radnih listova

Svaki od ovih jezicaka, poput onih u adresaru, predstavlja jedan radni
list u radnoj svesci. Broj listova u radnoj svesci nije odreden, a svaki list
ima jezicak sa svojim imenom.

Dugme za umetanje radnog lista

Svaka nova radna sveska podrazumevano ima tri radna lista. Novi list
Cete dodati ako pritisnete dugme Insert Worksheet (nalazi se iza posled-
njeg jezicka lista).
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Tabela 1.1: Delovi Excelovog prozora koje morate znati (nastavak)

Naziv Opis

Dugmad za pomeranje jezicaka  Pomocu ove dugmadi pomerate jezicke listova da biste dosli do onih
listova radnih listova Ciji se jezicci ne vide.

Statusna traka Na ovoj traci se prikazuju razne poruke, kao i stanje tastera Num Lock,

Caps Lock i Scroll Lock. Na njoj se vide i informacije o izabranom
opsegu Celija. Desnim tasterom misa pritisnite statusnu traku da biste
izabrali vrstu informacija koja ¢e na njoj biti prikazana.

Lista jezicaka Pomocu ovih jezicaka, na traci s komandama prikazivacete razlicite
kartice, slicno menijima.

Naslovna traka Na njoj su prikazani ime programa i ime tekuce radne sveske, kao i
neka kontrolna dugmad za podeSavanje prozora.

Vertikalna klizna traka Omogucava vertikalno pomeranje sadrzaja radnog lista.

Dugme za zatvaranje prozora Kada pritisnete ovo dugme, zatvarate prozor aktivne radne sveske.

Dugme za maksimiranje / Kad pritisnete ovo dugme, prozor radne sveske Ce se povecati tako da

vra¢anje prozora na prethodnu ispuni ceo Excelov radni prostor. Ako je prozor ve¢ povecan, a vi priti-

veli¢inu snete ovo dugme, vraticete Excelov prozor na prvobitnu veli¢inu (tako

da ne ispunjava ekran).

Dugme za minimiziranje prozora Ako pritisnete ovo dugme, sazecete prozor radne sveske koji ¢e biti pri-
kazan kao ikonica.

Kontrola uvecéanja Pomocu ovog klizaca mozZete uvelicavati i umanjivati prikaz radnog lista.

Kretanje po radnom listu
U ovom odeljku opisujemo kako se mozete kretati od jedne do druge ¢elije na radnom listu.
Svaki radni list se sastoji od redova (obelezenih brojevima od 1 do 1.048.576) i kolona
(oznacenih slovima od A do XFD). Iza kolone Z dolazi kolona AA, a potom AB, AC itd.
Nakon kolone AZ sledi BA, BB itd. Iza kolone ZZ nalazi se kolona AAA, AAB i tako dalje.
Presek reda i kolone je jedna Celija. U bilo kom trenutku, samo jedna celija moze biti
aktivna. Prepoznacete je po tamnom okviru, kao $to je prikazano na slici 1.2. Njena adresa
(slovo njene kolone i broj njenog reda) pojavljuje se u polju za ime. Dok se kreéete kroz radnu
svesku, aktivna celija moze da se menja, ali i ne mora, $to zavisi od tehnike koju koristite za
kretanje.

Slika 1.2: A S [P S S F F 6 2
. RTINS 1 prodle god. ove god
Aktivna Celija je ona 2 ljanuar a8 103
s tamnim okvirom 3 |februar 72 103
lu&ai 4 |mart 72 106 =
— uovom slucaju, & |apri 73 110
C’e“ja C8. 6 |maj 74 112
7 |jun 76 116
m —
10
1"
12 [~
4 4+ M| Sheetl Sheet2 Sheet? ¥J T4 [ K

Zaglavlja reda i kolone aktivne Celije prikazana su drugom bojom, pa se lakse uocavaju.
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Kretanje pomocu tastature

Kao §$to verovatno ve¢ znate, za kretanje po radnom listu mozete da koristite standardne
tastere sa strelicama. Oni rade kao $to ocekujete: strelica nadole pomera aktivnu Celiju za
jedan red nanize, strelica nadesno pomera je za jednu kolonu udesno itd. Tasteri PgUp i
PgDn pomeraju aktivnu Celiju za ceo prozor nagore odnosno nadole (broj redova za koje ¢e
se Celija pomeriti zavisi od broja redova koji su prikazani u prozoru).

SAVET Ako ukljucite taster Scroll Lock, preko tastature moZete pomerati sadrzaj radnog lista na
ekranu, a da pri tome ne menjate aktivnu ¢eliju. Ovo je korisno ako treba da pogledate drugi deo
radnog lista, a zatim se brzo vratite na prvobitno mesto. Pritisnite taster Scroll Lock i onda se
pomocu tastera sa strelicama krecite po radnom listu. Kad hocete da se vratite na pocetnu
poziciju (aktivnu eliju), pritisnite Ctrl+Backspace. Zatim ponovo pritisnite Scroll Lock da biste
ga iskljucili. Kad je ova funkcija ukljucena, Excel na statusnoj traci na dnu prozora prikazuje
poruku Scroll Lock.

Pomocu tastera Num Lock odreduje se ponasanje tastera na numerickoj tastaturi. Kada je
ukljucen, Excel na statusnoj traci prikazuje poruku Num Lock, a tasteri na numerickoj tastaturi
daju brojeve. Vedina tastatura ima poseban skup tastera sa strelicama, levo od numericke
tastature. Status tastera Num Lock ne utice na te tastere.

U tabeli 1.2 dat je pregled svih Excelovih tastera za kretanje po radnom listu.

Tabela 1.2: Tasteri za kretanje po Excelovom radnom listu

Taster Komanda
Strelica nagore Pomera aktivnu éeliju za jedan red navise.
Strelica nadole Pomera aktivnu €eliju za jedan red nanize.

Strelica ulevo ili Shift+Tab ~ Pomera aktivnu Celiju za jednu kolonu ulevo.

Strelica udesno ili Tab Pomera aktivnu ¢eliju za jednu kolonu udesno.

PgUp Pomera aktivnu Celiju za jedan ekran navise.

PgDn Pomera aktivnu ¢eliju za jedan ekran nanize.

Alt+PgDn Pomera aktivnu €eliju za jedan ekran udesno.

Alt+PgUp Pomera aktivnu Celiju za jedan ekran ulevo.

Ctrl+Backspace Pomera sadrzaj tako da se vidi aktivna Celija.

Strelica nagore” Pomera ekran za jedan red navise (aktivna celija se ne menja).
Strelica nadole” Pomera ekran za jedan red nanize (aktivna celija se ne menja).
Strelica ulevo” Pomera ekran za jednu kolonu ulevo (aktivna celija se ne menja).
Strelica udesno” Pomera ekran za jednu kolonu udesno (aktivna ¢elija se ne menja).

* Sa ukljucenim tasterom Scroll Lock

Kretanje pomoc¢u misa

Da biste promenili aktivnu ¢eliju pomoc¢u misa, postavite pokaziva¢ na neku drugu ¢eliju, pri-
tisnite taster misa i ta Celija ée postati aktivna. Ako se Celija koju Zelite da aktivirate ne vidi u
prozoru radne sveske, pomo¢u kliznih traka mozete da pomerate radni list u bilo kom pravcu.
Da biste ga pomerili za jednu Celiju, pritisnite odgovarajucu strelicu na kraju klizne trake. Kad
hocete da pomerite prozor za ceo ekran, pritisnite prostor na kliznoj traci pored dugmeta za
pomeranje sadrzaja sa odgovarajuce strane. Povlacite to dugme da bi se sadrzaj brze pomerao.
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SAVET Da biste vertikalno pomerali sadrzaj, mozete da koristite i tocki¢ ukoliko ga vas mis
ima. Ako pritisnete tocki¢ i pomerite misa u bilo kom pravcu, radni list ¢e se automatski pomerati
u istom pravcu. Sto vise budete pomerali misa, to Ce se sadrzaj brze kretati.

Da biste pomo¢u tocki¢a mis$a uvelicali ili umanjili prikaz radnog lista, drzite pritisnut
taster Ctrl dok okrecete tocki¢. Ukoliko Zelite da zumirate tocki¢em a da ne drzite taster Ctrl,
odaberite File => Options i izaberite odeljak Advanced. Potvrdite polje Zoom on Roll with
Intellimouse.

Ako sadrzaj pomerate pomocu kliznih traka ili pomoc¢u misa s to¢ki¢em, necete pomeriti
aktivnu Celiju. Tako se pomera samo sadrzaj. Da biste aktivirali neku drugu Celiju, nakon §to
pomerite sadrzaj morate je pritisnuti.

Traka s komandama

Najkrupnija promena uvedena u paketu Office 2007, jeste novo korisnicko okruzenje. U
vedini programa iz paketa Office 2007, tradicionalni meniji i palete alatki zamenjeni su tra-
kom s komandama (engl. Ribbon). U Officeu 2010, sve aplikacije imaju korisnicko okruzenje
s trakom. Pored toga, u Officeu 2010 traka se moze prilagoditi (videti poglavlje 23).

Kartice trake s komandama
Komande dostupne na traci zavise od izabrane kartice. Traka je organizovana u grupe pove-
zanih komandi. Sledi kratak pregled Excelovih kartica.

B Home Najvise Cete raditi uz izabranu karticu Home. Ona sadrzi osnovne komande za
rad sa Clipboardom, za formatiranje, stilove, umetanje i brisanje redova ili kolona i
izbor komandi za uredivanje radnih listova.

B Insert Izaberite ovu karticu kada u radni list treba da umetnete nesto — tabeluy, dija-
gram, grafikon, simbol itd.

B Page Layout Na ovoj kartici se nalaze komande koje uti¢u na opsti izgled radnog lista,
ukljucujudi i neke parametre koji se odnose na Stampanje.

B Formulas Koristite ovu karticu da biste dodali formulu, imenovali ¢eliju ili opseg, dosli
do alatki za menjanje formula ili upravljali na¢inom na koji Excel obavlja izra¢unavanja.

B Data Na ovoj kartici su Excelove komande za rad s podacima.

B Review Na ovoj kartici nalaze se alatke za proveru pravopisa, prevodenje re¢i, doda-
vanje komentara ili zastitu listova.

B View Kartica View sadrzi komande za upravljanje raznim aspektima prikaza lista.
Neke komande sa ove kartice dostupne su i na statusnoj traci.

B Developer Ova kartica nije podrazumevano dostupna. Sadrzi komande koje ¢e kori-
stiti programeri. Da biste prikazali njen jezi¢ak, odaberite File &> Options, a potom
izaberite Customize Ribbon. U desnom oknu pod nazivom Customize the Ribbon,
potvrdite polje Developer i pritisnite OK.

B Add-Ins Jezicak ove kartice videdete samo ako ste ucitali staru radnu svesku ili
dodatni program za prilagodavanje menija ili paleta alatki. Posto u Excelu 2010 vise
nema menija i paleta alatki, dodaci za prilagodavanje korisnickog okruzenja bice
dostupni na kartici Add-Ins.
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NAPOMENA lako je dugme File prvo u nizu kartica, ono ipak nije kartica. Kad pritisnete
dugme File, otvorice se nov prozor sa tzv. prikazom iza scene (engl. Back Stage View), sa opci-
jama za rad s dokumentima.

Prikaz komandi na traci zavisi od $irine Excelovog prozora. Kada je prozor preuzak da bi
se sve videlo, prikaz komandi ¢e biti prilagoden i mozda ¢e vam se u¢initi da neke nedostaju.
Medutim, one ¢e i dalje biti dostupne. Slika 1.3 prikazuje karticu Home na kojoj se vide sve
kontrole. Slika 1.4 prikazuje traku s komandama kada je Excelov prozor uzi. Nestao je deo
opisnog teksta, ali su ikonice i dalje tu. Slika 1.5 prikazuje ekstreman slucaj kada je prozor
veoma suzen. U nekim grupama vidi se samo po jedna ikonica. Medutim, ako pritisnete
ikonicu, sve komande u grupi bi¢e dostupne.
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Slika 1.3: Kartica Home trake s komandama.
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Slika 1.4: Kartica Home kada je Excelov prozor suzen.
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Slika 1.5: Kartica Home kada je Excelov prozor veoma suzen.

SAVET Ako Zelite da sakrijete traku s komandama da biste povecali prikaz radnog lista, dvaput
pritisnite bilo koji jezi¢ak. Traka ¢e nestati i moci Cete da vidite jo$ oko pet redova radnog lista.
Kada vam traka ponovo zatreba, pritisnite jezicak neke kartice i ona ce se privremeno vratiti. Da
bi traka s komandama ostala ukljucena, dvaput pritisnite jezicak kartice. Prikaz trake moZzete
ukljucivati i iskljucivati i pomocu precice Ctrl+F1.

Kontekstne kartice

Pored standardnih kartica, Excel 2010 sadrzi i kontekstne kartice (engl. contextual tabs). Kada
je izabran neki objekat (dijagram, tabela ili SmartArt dijagram), odredene alatke za rad s tim
objektom bi¢e dostupne na traci s komandama.

Slika 1.6 prikazuje tri kontekstne kartice koje se pojavljuju kada je izabran dijagram:
Design, Layout i Format. Na Excelovoj naslovnoj traci prikazan je opis kontekstnih kartica
(Chart Tools — alatke za rad s dijagramima). Naravno, kada su one prikazane, i dalje mozete
koristiti ostale kartice.
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Slika 1.6: Kada izaberete neki objekat, pojavice se kontekstne kartice sa alatkama za rad s tim objektom.

Vrste komandi na traci

Kada na komandi s trake zadrzite pokaziva¢ misa, pojavice se iskacuce polje sa imenom i
kratkim opisom komande. Komande na traci uglavnom funkcioni$u onako kako i oc¢ekujete.
Na traci postoji nekoliko stilova komandi:

B Obic¢na dugmad Pritisnite dugme i ono e nesto uraditi. Primer obi¢nog dugmeta je
Increase Font Size (povecaj font) iz grupe Font na kartici Home. Neka dugmad odmah
obavljaju akciju, a druga otvaraju okvir za dijalog da biste uneli dodatne parametre. Uz
dugmad moze stajati opisni tekst, ali ne mora.

B Dugmad za ukljucivanje i iskljuc¢ivanje Takvo dugme mozete pritisnuti, a njegova
boja ¢ée biti razli¢ita, zavisno od statusa. Primer je dugme Bold iz grupe Font na kartici
Home. Ukoliko sadrzaj aktivne Celije nije ispisan podebljano (engl. bold), dugme Bold
¢e imati normalnu boju. Ako je za aktivnu Celiju ve¢ odabran atribut Bold, pozadina
dugmeta Bold bi¢e drugacije boje. Pritiskanjem tog dugmeta, ukljucivacete i iskljuci-
vati atribut Bold za izabranu Celiju.

B Dugmad sa obi¢nom padajuc¢om listom Ukoliko se uz komandu na traci nalazi stre-
lica nadole, komanda sadrzi padajucu listu. Pritisnite je i ispod nje ¢e se pojaviti
dodatne komande. Primer takve komande je Conditional Formatting iz grupe Styles na
kartici Home. Kada je pritisnete, videcete jo$ nekoliko opcija za uslovno formatiranje.

B Podeljena dugmad U kontrolama s podeljenim dugmetom kombinovani su aktivi-

ranje akcije jednim pritiskom i padajuca lista. Ako pritisnete deo s dugmetom, komanda
Ce se izvrsiti. Ukoliko pritisnete deo za padajucu listu (strelicu nadole), mozete odabrati
neku srodnu komandu s liste. Podeljeno dugme prepoznacete po tome $to Ce biti prika-
zano u dve boje kada na njega postavite pokaziva¢ misa. Primer podeljenog dugmeta je
komanda Merge & Center iz grupe Alignment na kartici Home (slika 1.7). Ako pritisne-
te levi deo ove kontrole, stopicete i centrirati tekst u izabranim ¢elijama. Kada pritisnete
deo sa strelicom (desni), pojavice se lista komandi za stapanje Celija.
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merge Cells

Split the selected cells into muttiple
new cells,

B Polja za potvrdu Kontrole s poljima za potvrdu sluze za ukljuivanje i iskljucivanje
necega. Primer je kontrola Gridlines iz grupe Show na kartici View. Kada je polje Grid-
lines potvrdeno, na radnom listu Ce biti prikazane linije mreze. Ukoliko nije
potvrdeno, linije se nece videti.

B Broja¢i Na Excelovoj traci postoji samo jedna kontrola s broja¢em. Nalazi se u grupi
Scale To Fit na kartici Page Layout. Pritisnite gornji deo brojac¢a da biste povecali
vrednost, a donji deo da biste smanjili vrednost.

Na desnoj strani nekih grupa na traci nalazi se i ikonica za pokretanje okvira za dijalog
(engl. dialog launcher). Na primer, u grupi Home = Alignment, videcete tu ikonicu (slika
1.8). Pritisnite je i Excel ¢e otvoriti okvir za dijalog Format Cells u kom ¢e kartica Alignment
ve¢ biti izabrana. Pokretaci okvira za dijalog obi¢no nude opcije koje nisu dostupne na traci.

Slika 18: Farmulas Data Review View
Neke grupe natraci, .
na svojoj desnoj

strani sadrze ikonicu
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Farmat Cells dialog box.

KoriS¢enje trake s komandama pomocu tastature

Na prvi pogled, mogli biste pomisliti da je traku s komandama najlakse koristiti pomocu misa.
Ako nista drugo, na to bi mogla ukazivati ¢injenica da nijedna komanda nema tradicionalno
podvudeno slovo koje oznacava precicu uz koriséenje tastera Alt. Ipak, traka je veorna pogodna
za rad preko tastature. Slova za precice s tastature bice prikazana kada pritisnete taster Alt.
Svaka kontrola na traci ima slovo (ili vi$e slova) koja ete pritisnuti da biste zadali komandu.

SAVET Ne morate drzati pritisnut taster Alt dok pritiskate tastere za odredenu precicu.
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Na slici 1.9 vidi se kartica Home nakon pritiskanja tastera Alt da bi se ukljucio prikaz
tastera za precice. Ako pritisnete jednu precicu, na ekranu Ce se prikazati jos tastera za
precicu. Na primer, da biste pomocu tastature poravnali sadrzaj Celije ulevo, pritisnite Alt, a
potom taster H (za karticu Home) i AL (za komandu Align Left). Tesko je nauciti napamet sve
te precice, ali ukoliko volite da koristite tastaturu (kao ja), nakon samo nekoliko pokusaja
zapamticete tastere za pokretanje komandi koje ¢esto koristite.
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Slika 1.9 Kada pritisnete taster Alt, prikazace se tasteri za precice s tastature.

Posto pritisnete taster Alt, kroz kartice se mozete kretati pomocu strelica ulevo i udesno.
Kada dodete do trazene kartice, pritisnite strelicu nadole da biste presli na traku s koman-
dama. Potom se strelicama ulevo i udesno kreéite kroz komande. Kada dodete do trazene
komande, pritisnite taster Enter da biste je izvr$ili. Ova metoda nije tako efikasna kao
koriscenje precica s tastature, ali je brz nacin da pregledate dostupne komande.

Upotreba prirucnih menija

Pored trake s komandama, Excel ima i mno$tvo prirucnih menija (engl. shortcut menu), koje
otvarate tako $to desnim tasterom misa pritisnete bilo gde u Excelovom prozoru. Priru¢ni
meniji nemaju sve komande koje se odnose na izabrani element, ve¢ samo one koje se naj-
cesce koriste.

Primera radi, na slici 1.10 prikazan je priru¢ni meni koji se pojavljuje kad desnim tasterom
misa pritisnete ¢eliju. Meni se pojavljuje na mestu pokaziva¢a misa, pa se komande biraju brzo
i efikasno. Koji je priru¢ni meni prikazan, zavisi od toga $ta je u tom trenutku izabrano.
Recimo, ako radite na dijagramu, priru¢ni meni sadrzi komande koje se odnose na izabrani
element dijagrama.

Polje iznad priru¢nog menija naziva se mini-paleta alatki i sadrzi najé¢esce koricene alatke s
kartice Home. Mini-paleta skracuje put koji morate prelaziti misem po ekranu. Samo pritisnite
desni taster misa i najée$ce alatke za formatiranje bice na par centimetara od pokaziva¢a misa.
Ona je narocito korisna kada nije prikazana kartica Home. Ukoliko koristite alatku s mini-
-palete, ona e ostati prikazana za slucaj da hocete dodatno da formatirate izabrane Celije.

Prilagodavanje palete alatki Quick Access

Tako traka s komandama omogucava prili¢no efikasan rad, mnogim korisnicima vie odgo-

vara da im neke komande uvek budu pri ruci, tj. da ih ne moraju traziti po karticama. Resenje
je da prilagode paletu Quick Access (za brz pristup opcijama). Ona se obi¢no nalazi na levoj
strani naslovne trake, iznad trake s komandama, ali je vi moZete premestiti i ispod trake tako

§to Cete je pritisnuti desnim tasterom misa i izabrati opciju Show Quick Access Toolbar below
the Ribbon.
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Ukoliko vam mini-paleta alatki smeta, mozete izgubiti sate tragajuci za nacinom da je
iskljucite. Na kartici General Excelovog okvira za dijalog Options nalazi se opcija Show
Mini Toolbar on Selection, ali se ona odnosi na biranje znakova prilikom uredivanja
sadrzaja Celije. Mini-paleta se nece prikazivati nakon pritiska desnog tastera misa samo
ako izvrsite VBA makro:

Sub ZapMiniToolbar ()
Application.ShowMenuFloaties = True
End Sub

Mozda ¢e vam se uciniti da je ovaj iskaz pogresan, ali ipak je tacan. Zadavanjem svoj-
stva True, mini-paleta se iskljucuje. Ta greska se pojavila u Excelu 2007 i nije ispravljena
u Excelu 2010 jer zbog takve ispravke mnogi makroi ne bi radili. (U delu VI procitajte
vise o VBA makroima.)

Kada je paleta Quick Access ispod trake, na njoj ima malo vise prostora za ikonice ali to

takode podrazumeva da Ce se prikaz radnog lista umanjiti za jedan red.

Paleta Quick Access podrazumevano sadrzi tri alatke: Save, Undo i Repeat. Naravno,

mozete je izmeniti tako $to cete joj dodati druge komande koje ¢esto koristite. Da biste

komandu s trake dodali paleti Quick Access, pritisnite komandu desnim tasterom misa i oda-

berite opciju Add to Quick Access Toolbar. Ako pritisnete strelicu nadole desno od palete
Quick Access, videcete padajudi meni s dodatnim komandama koje biste mozda hteli da
postavite na tu paletu.
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Neke Excelove komande nisu dostupne na traci s komandama. U veéini slucajeva, do tih
komandi modi éete da dodete ako ih dodate paleti Quick Access. Desnim tasterom misa priti-
snite paletu Quick Access i izaberite Customize Quick Access Toolbar. Otvorice se okvir za
dijalog sa slike 1.11. U prikazanom odeljku okvira za dijalog Excel Options zavr$avacete kom-
pletno prilagodavanje palete Quick Access.

REFERENCA U poglavlju 23 pronaci cete jos informacija o prilagodavanju palete Quick

Access.
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Gotovo svaku akciju u Excelu mozete opozvati komandom Undo s palete alatki Quick
Access. Izaberite je (ili na tastaturi pritisnite Ctrl+Z) ako ste zadali pogresnu komandu i sve
Ce biti kao pre. Uzastopnim izvrsavanjem komande Undo moZzete da ponistite poslednjih
100 zadatih komandi.

Ukoliko pritisnete strelicu na desnoj strani dugmeta Undo, dobicete opise akcija koje
mozete da ponistite. Ako pritisnete stavku s liste, izabrana akcija i sve naredne akcije
bice ponistene.

UPOZORENJE Medutim, ne mozete ponistiti svaku akciju. Uopsteno govoredi, nista $to ura-
dite pomoc¢u dugmeta File ne mozZe se ponistiti. Na primer, ako snimite datoteku i shvatite da ste
loSom verzijom datoteke zamenili dobru verziju, nema vam pomoci.

Dugme Repeat, takode dostupno na paleti alatki Quick Access, obavlja suprotnu operaciju
od komande Undo: ponovo izvr§ava komande koje su bile opozvane komandom Undo. Ako
nijedna komanda nije ponistavana, pomocu dugmeta Repeat (ili precice Ctrl+Y) mozete
ponoviti poslednju izvedenu komandu. Na primer, ako ste Celiji dodelili odredeni stil (tako
§to ste izabrali Home = Styles = Cell Styles), mozete aktivirati jo$ jednu Celiju i pritisnuti
Ctrl+Y da biste ponovili tu komandu.
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Rad sa okvirima za dijalog

Okviri za dijalog se pojavljuju kao odgovor na mnoge komande. Oni su Excelov na¢in da od
vas dobije vi$e podataka. Recimo, ako izaberete komandu Review => Changes => Protect Sheet,
Excel ne moze da je izvr$i dok mu ne kazete koje delove lista hocete da zastitite. Zbog toga ce
prikazati okvir za dijalog Protect Sheet (slika 1.12).

Slika 1.12: Protect Sheet 2=
Excel koristi okvir za Protect worksheet and contents of locked cells
dijalog da bi dobio Tl m o

vise podataka o

komandi. Allow all users of this worksheet to:

[Ed Select locked cells
Select unlocked cells
[C]Format cells
[C]Format columns
Format rows

[ tnsert columns

[ tnsert rows

[ tnsert hyperlinks
|| Delete columns

[T Delete rows 2

m

Excelovi okviri za dijalog razli¢ito funkcioni$u, a podeljeni su na dve vrste:

B Obican okvir za dijalog: Modalni okvir za dijalog koji uklanja fokus s radnog lista.
Kada je otvorena ova vrsta okvira, na radnom listu ne mozete uraditi ni$ta dok ne za-
tvorite okvir za dijalog. Ako pritisnete dugme OK, bice izvedene zadate akcije, a ako
pritisnete Cancel (ili taster Esc), zatvoriéete okvir za dijalog bez izvrsavanja akcija.
Veéina Excelovih okvira za dijalog ovog su tipa.

B Okvir za dijalog koji ostaje na vrhu: Nemodalni okvir za dijalog, koji funkcionige sli¢no
paleti alatki. Kada je prikazan ovakav okvir za dijalog, mozZete nastaviti da radite u
Excelu, a okvir za dijalog ¢e ostati otvoren. Promene zadate u nemodalnom okviru za
dijalog odmabh se primenjuju. Na primer, ako formatirate dijagram, promene koje napra-
vite u okviru za dijalog Format odmah (e se pojaviti na dijagramu. Nemodalni okviri za
dijalog imaju dugme Close umesto dugmeta OK i pomocu njega Cete ih zatvoriti.

Za vedinu ljudi, rad sa okvirima za dijalog jednostavan je i logi¢an. Ukoliko ste navikli na
druge programe, i ovde Cete se osecati kao kod kude. Kontrolama u okviru za dijalog upra-
vljadete miSem ili preko tastature.

Kretanje u okvirima za dijalog

Obicno je lako kretati se u okviru za dijalog: samo pritisnete kontrole koje hodete da aktivirate.
Iako su okviri dizajnirani za one koji se sluze miSem, mozZete da koristite i tastaturu. Svaka

kontrola okvira za dijalog ima prateci tekst, koji uvek ima jedno podvuceno slovo (vruci taster

ili taster za precicu). Kad pritisnete taster Alt i zatim podvuceno slovo, kontroli mozete pristu-

pitiis tastature. Takode, pomocu tastera Tab mozete kruziti kroz sve kontrole u okviru za

dijalog. Pomoc¢u kombinacije Shift+Tab kruzite kroz kontrole u suprotnom smeru.
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SAVET Kad izaberete kontrolu, oko nje se pojavljuje isprekidana linija. Da biste aktivirali
izabranu kontrolu, moZete upotrebiti razmaknicu.

Upotreba okvira za dijalog s karticama
Mnogi Excelovi okviri za dijalog imaju kartice. To znaci da imaju jezicke kao u adresaru i
svaki je povezan sa odgovaraju¢om karticom.

Kad pritisnete jezi¢ak, pojaviée se odgovarajuca kartica s novim skupom kontrola. Dobar
primer je okvir za dijalog Format Cells. On je prikazan na slici 1.13; ima $est kartica, $to je
isto kao da imamo Sest okvira za dijalog.

Slika 1.13: Format Cells B[=]
Pomocu kartica u g g S :
. .. Humber | Alignment | Font | Border | Fil_| Protection |
okviru za dijalog
Category:

birate razlicite funk-
cionalne oblasti.

Sample
110,00

Accaunting
Date

Cecimal places: |2 fi{

Time [[] Use 1000 Separator {3
Percentage

Fraction Megative numbers:
Scientific

Text 1234,10

Spedial -1234,10

Custam -1234,10

Mumber is used For general display of numbers, Currency and Accounting offer specialized
Farmatting For monetary value.

Okviri za dijalog s karticama vrlo su prakti¢ni jer moZete da promenite vise opcija na jed-
nom mestu. Kad zavrsite, pritisnite dugme OK ili taster Enter.

SAVET Da biste izabrali karticu preko tastature, koristite kombinaciju tastera Ctrl+PgUp ili
Ctrl+PgDn, ili samo pritisnite prvo slovo imena kartice koju hocete da aktivirate.

U Excel 2007 uveden je nov tip nemodalnih okvira za dijalog s karticama u kojima su kar-
tice prikazane na levoj strani, umesto duz vrha okvira. Excel 2010 nastavlja s takvim stilom.
Nemodalni okvir za dijalog s karticama, Format Shape, prikazan je kao primer na slici 1.14.
Kad hocete da izaberete karticu pomodu tastature, koristite strelice nagore i nadole, a potom
pritisnite Tab da biste dosli do opcija s kartice.

Koris¢enje okna s poslovima

Poslednji element okruZenja koji ¢u objasniti jeste okno s poslovima (engl. task pane). Okno
s poslovima se pojavljuje automatski, kao odgovor na nekoliko komandi. Na primer, ako
hodete da umetnete slicicu iz kolekcije Clip Art, odaberite Insert = Illustrations = Clip Art.
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Slika 1.14: Format Shape
Okvir za dijalog s

karti levo Fil Shadow
ar |(?ama na levoj line Color reses:
strani. Line Style
Color:

Reflection Transparency: U—
Glow and Soft Edges Size: U
3-D Format Blur: D
3D Ratation angle: —
Picture Corrections Distance: Di

Picture Color
Artistic Effects
Crop

Size
Properties
Text Box

Alt Text

Excel ¢e prikazati okno s poslovima za Clip Art (slika 1.15). Okno s poslovima je sli¢no
okviru za dijalog, ali ostaje vidljivo koliko Zelite. Nema dugmeta OK. Kada vam okno vise ne
treba, pritisnite dugme Close u gornjem desnom uglu.

Slika 1.15: Clip Art X
Okno s poslovima Search for:
Clip Art. [pusiness |
Searchin:
|N| collections |z|
Results should be:
|NI media file types |z|

Q0 &
S,

E:'J clip art on Office Online
(@ Tips for finding dips

Okno s poslovima je podrazumevano usidreno s desne strane Excelovog prozora, ali ga
mozete premestiti gde Zelite tako $to Cete pritisnuti njegovu naslovnu traku i odvuéi na odgo-
varajuce mesto. Bududi da Excel pamti njegovu poslednju poziciju, kad slede¢i put budete
koristili to okno s poslovima, ono ¢e biti tamo gde ste ga ostavili.
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Izrada prvog radnog lista

U ovom odeljku mo¢i éete da provezbate rad u Excelu na prakticnom primeru: napravicete
jednostavnu tabelu predvidenih mese¢nih prihoda i odgovarajudi dijagram. Ako ranije niste
koristili Excel, pratite nasa uputstva i uz to radite na racunaru, pa Cete tako najbolje ste¢i
osecaj kako funkcionise ovaj softver.

Pocetak izrade radnog lista
Pokrenite Excel i proverite da li je prikazana prazna radna sveska. Da biste napravili novu,
praznu radnu svesku, pritisnite Ctrl+N (precica za komandu File &> New => Blank Workbook
> Create).

Podaci o predvidenim prihodima nalazice se u tabeli s dve kolone. U koloni A biée nazivi
meseci u godini, a u koloni B iznosi predvidenih prihoda. Najpre unesite zaglavlja sa opisom
na radni list, i to na slededi nacin:

1. Pomocu tastera sa strelicama, postavite pokaziva¢ na celiju Al (u gornjem levom uglu
radnog lista). U polju za ime prikazace se adresa Celije.

2. U éeliju Al upisite Mesec i nakon toga pritisnite Enter. Zavisno od toga kako je Excel
podesen, pokaziva¢ ¢e se premestiti na drugu ¢eliju ili ostati na Celiji Al.

3. Pomerite pokaziva¢ na Celiju B1, upisite Predvideni prihodi i pritisnite Enter.

Uneseni tekst premasuje $irinu Celije, ali o tome zasad ne treba da brinete.

Upisivanje imena meseci
U ovom koraku upisaéete imena meseci u kolonu A.

1. Pomerite pokaziva¢ na Celiju A2 i za mesec januar unesite jan. Umesto da ru¢no popu-
nite éelije skrac¢enicama preostalih meseci, iskoristite Excelovu funkciju AutoFill koja
¢e to uraditi automatski.

2. Proverite da li je aktivna Celija A2. Obratite paZnju na to da je oko aktivne Celije taman
okvir i da se u donjem desnom uglu nalazi mali kvadrat koji se zove rucica za auto-
matsko popunjavanje (engl. fill handle). Postavite pokaziva¢ misa na rudicu, pritisnite je
i povucite sve dok ne izaberete Celije od A2 do A13.

3. Pustite taster misa i Excel ¢e automatski popuniti izabrane Celije imenima meseci.

Vas radni list trebalo bi da izgleda kao na slici 1.16.

Slika 1.16: A F) C D E F G H i
Radm I]St nakon $to 1 [Mesec _Z‘redwfemprihodi

. . . 2 |jan
ste upisali zaglavlja W ieo

kolona i nazive 4 mar

meseci. apr
maj

jun
jul

9 |avg
10 |sep
11 okt
12 \nov
13 |dec
14

15

5
6
7
8
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Upisivanje podataka o prihodima
U kolonu B upisacete vrednosti predvidenih prihoda. Pretpostavimo da je planiran januarski
prihod 50.000 dinara, sa rastom od 3,5% u svakom narednom mesecu.

1. Pomerite pokaziva¢ na éeliju B2 i upisite 50000, $to e predstavljati predvideni prihod
za januar. MoZete uneti i znak za valutu da bi broj bio ¢itljiviji, ali Cete se formatira-
njem brojeva pozabaviti malo kasnije.

2. Da biste uneli formulu za izra¢unavanje predvidenih prihoda za februar, pomerite
pokazivac na Celiju B3 i upisite =B2*103,5%. Kad pritisnete Enter, u Celiji ¢e se prika-
zati 51750, §to znaci da je u formuli pomnoZena vrednost Celije B2 sa 103,5%. Drugim
re¢ima, predvida se da Ce februarski prihod biti veci od jan..uarskog za 3,5%.

3. Predvideni prihodi u narednim mesecima izra¢unavace se pomocu sli¢ne formule. Da
ne biste formulu ru¢no upisivali u svaku Celiju kolone B, opet upotrebite funkciju
AutoFill. Proverite da li je aktivna Celija B3. Pritisnite miSem njenu rucicu za automat-
sko popunjavanje, povucite do Celije B13 i pustite taster mia.

Sada bi va$ radni list trebalo da izgleda kao na slici 1.17. Imajte na umu da se, osim u
slucaju ¢elije B2, vrednosti kolone B izra¢unavaju pomocu formula. Primera radi, izmenite
predvidenu vrednost za januar (u Celiji B2). Videcete da Ce rezultati formula biti drugadiji jer
sve one zavise od vrednosti Celije B2.

Slika 1.17: A B g D E F
B 1 |Mesec Predvideni prihodi

Rad[ﬂ I{st nakon 2 lian £0000
unosenJa formula. 3 feb 51750

4 |mar 5356125

5 |apr 55435,8938

6 |maj 57376.15

7 |jun 59384,3153

8 |jul 61462,7663

9 |avg 63613,9631

10 |sep 65840.4518

11 |okt 65144,8677

12 |nov 70529,938

13 |dec 72998 4859

14

15

Formatiranje brojeva
Vrednosti na radnom listu tesko se ¢itaju jer nisu formatirane. U slede¢em koraku formati-
radete brojeve da bi se lakse ¢itali i da bi izgled lista bio dosledniji.

1. Izaberite brojeve tako $to éete pritisnuti ¢eliju B2 i povuéi nadole do ¢elije B13.
SAVET Ovaj put ne povlacite ru¢icu za popunjavanje jer sada birate Celije, ne popunjavate niz.

2. Odaberite Home = Number, pritisnite strelicu za padajucu listu kontrole Number For-
mat (na pocetku je prikazana opcija General) i s liste odaberite opciju Currency. Brojevi
¢e sada biti prikazani sa oznakom valute i s dva decimalna mesta. Ve¢ je mnogo bolje!



Poglavlje 1: Uvod u Excel 21

Doterivanje radnog lista
Imate radni list koji radi ono $to treba i sada biste mogli malo da ga doterate. Za tren oka,
opseg Celija pretvoriéete u ,zvani¢nu® (i lepu) Excelovu tabelu:
1. Predite u bilo koju ¢eliju unutar opsega.
2. Odaberite Insert = Tables = Table. Excel ¢e prikazati okvir za dijalog Create Table kako
bi proverio da li je ispravno predvideo opseg Celija koji hocete.
3. Pritisnite OK da biste zatvorili okvir za dijalog Create Table. Excel ¢e primeniti podra-
zumevano formatiranje tabele i prikazati kontekstnu karticu Table Tools => Design.
Radni list bi trebalo da izgleda kao na slici 1.18.

Slika 1.18: A B C D
Radni list nakon (il Mesec Kd M|
pretvaranja opsega g JfaE :?ggggg g!”-
T = _750,00 Din.
celija u tabelu. 4 mar 53.561.25 Din.
5 |apr 55.435.89 Din.
6 |maj £7.376.15 Din.
7 |jun £9.384 32 Din.
g jul 61.462.77 Din.
9 |avg 63.613.96 Din.
10 sep 65.840.45 Din.
11 |okt 68.144 87 Din.
12 [nov 70.529 94 Din.
13 |dec 72.998.49 Din,
14
15

4. Ako vam se ne dopada podrazumevani stil tabele, izaberite drugi iz grupe Table Tools
> Design = Table Styles. Prikaz izgleda razlicitih stilova tabela pojavice se ako posta-
vite pokaziva¢ misa na traku s komandama. Kada pronadete stil koji vam se dopada,
pritisnite ga i on ¢e biti dodeljen tabeli.

Sabiranje vrednosti

Radni list prikazuje predvideni prihod od prodaje rasporeden po mesecima, ali $ta je sa ukup-
nim godi$njim prihodom? Posto je ovaj opseg Celija pretvoren u tabelu, lako Cete prikazati i
godisnju zaradu:

1. Aktivirajte bilo koju Celiju u tabeli.

2. Odaberite Table Tools = Design = Table Style Options => Total Row. Excel ¢e na dno
tabele automatski dodati nov red u kom ¢e biti formula za izra¢unavanje zbira vredno-
sti u koloni predvidenih prihoda.

3. Ukoliko vam treba drugacija formula za sabiranje (na primer, za izra¢unavanje pro-
se¢ne vrednosti), pritisnite eliju B14 i odaberite formulu s padajude liste.
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Izrada dijagrama
Sta mislite o dijagramu koji bi prikazivao predvidene prihode za svaki mesec?
1. Aktivirajte bilo koju Celiju u tabeli.
2. Odaberite Insert & Charts = Column i potom izaberite neki dvodimenzionalni stu-
bicasti dijagram. Excel ¢e umetnuti dijagram u sredinu ekrana.

SAVET Da biste premestili dijagram, pritisnite njegovu ivicu i povucite ga. Da biste promenili
izgled i stil dijagrama, upotrebite naredbe na kontekstnoj kartici Chart Tools.

Slika 1.19 prikazuje radni list nakon izrade stubicastog dijagrama. Vas dijagram ¢e mozda
izgledati drugacije, zavisno od izgleda ili stila koji ste izabrali.

i . ) 5 D E F G H 3
?":)‘33-13;. 8 iccec B predvident prindl]|
abela 1 dijagram. 2 |jan | 50.000.00 Din s s : s
Jag e SETEEE Predvideni prihodi
4 mar 53.561.25 Din. £0.000,00 Din.
5 |apr 55.435.89 Din.
6 |maj 57.376,15 Din. 70.000,00 Din
7 Jjun 59.384,32 Din 50.000,00 Din. -
3 jul 61462.77 Din
9 |avg 63 613 96 Din 50.000,00 Din.
10 |sep 65 840,45 Din 40.000,00 Din.
11 |okt 68 144.87 Din s0.000.00 0. |
12 |nov 70.529.94 Din 3
13 |dec 72.998.49 Din 20.000,00 Din.
}‘; 10.000,00 Din. 1
16 0,00 Din.
17 jan feb mar apr maj jun jul avg sep okt nov dec
18

CD Ova radna sveska se nalazi na prate¢cem CD-u.

Stampanje radnog lista
U Excelu je $tampanje radnih listova veoma jednostavno (pod uslovom da imate ispravan
$tampac povezan s racunarom).

1. Dijagram ne treba da bude izabran — ako jeste, bie od$tampan na posebnoj strani. Da
biste ponistili izbor dijagrama, pritisnite taster Esc ili bilo koju éeliju.

2. Da biste iskoristili Excelov nov i zgodan prikaz izgleda strane, pritisnite dugme Page
Layout View na desnoj strani statusne trake. Excel ¢e prikazati radni list stranicu po
stranicu pa lako mozete videti kako ¢e izgledati od§tampan dokument. Na slici 1.20
prikaz radnog lista je umanjen kako bi se videla cela strana. U prikazu Page Layout
mozete odmah videti da li je dijagram presirok da bi stao na jedan list. Ukoliko jeste,
pritisnite i povucite neki njegov ugao da biste mu promenili veli¢inu. Ili, premestite
dijagram ispod tabele s brojevima.

3. Kada budete spremni za $tampanje, odaberite File = Print. U ovom trenutku mozete
izmeniti neke parametre Stampanja. Primera radi, umesto u portretnoj (engl. portrait)
orijentaciji, mozete izabrati stampanje u pejzaznoj (engl. landscape) orijentaciji.
Unesite izmenu i rezultat ¢ete videti u prozoru za prikaz. Kada budete zadovoljni izgle-
dom, pritisnite dugme Print u gornjem levom uglu. Strana se §tampa, a vi se vracate u
svoju radnu svesku.



Poglavlje 1: Uvod u Excel 23

)01 Bockl dijagram pageview = BB
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C
i_ Click 1o add header

Predvideni prihodi

388885002 (8EE

A e T N | |
e » [

Slika 1.20: Pregledanje radnog lista u rezimu Page Layout.

Snimanje radne sveske

Sve §to ste dosad radili, desavalo se u memoriji racunara. Da nestane struja, sve bi bilo izgu-
bljeno — osim ako bi reagovala Excelova funkcija AutoRecover. Vreme je da snimite u dato-
teku na disku ono $to ste uradili.

1. Pritisnite dugme Save na paleti Quick Access (dugme sa sli¢icom diskete, popularne
u proslom veku). Posto ovu radnu svesku jo$ niste snimali i posto jo$ nosi podrazume-
vano ime, Excel ¢e prikazati okvir za dijalog Save As.

2. U polje File Name upisite, na primer, Predvideni mese¢ni prihodi, a zatim pritisnite
dugme Save ili taster Enter. Excel snima radnu svesku kao datoteku na disku. Radna
sveska ostaje otvorena da biste mogli i dalje raditi s njom.

NAPOMENA Excel svakih deset minuta podrazumevano snima ono $to ste radili. Da biste

u okviru za dijalog Excel Options. Medutim, nikada se nemojte oslanjati samo na Excelovu
funkciju AutoRecover. Mudro bi bilo da ¢esto snimate rad.

Ukoliko ste pratili prethodne korake, shvatili ste da nije narocito tesko napraviti radnu
svesku. Naravno, do sada jedva da ste zagrebali povrsinu. U ostatku knjige, ovi zadaci (kao
i mnogi drugi) bi¢e objasnjeni s mnogo vise detalja.



